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1 はじめに

MATLAB® Integration Package（MIP）は、ETAS の組み込み制御システム開発ツー
ル「ASCET」のアドオン製品で、MATLAB とのモデルデータ交換をサポートする以
下の 2 つの部分から構成されています。

• MATLAB® インターフェース は、シミュレーションデータの交換や MATLAB

関数のリモート呼び出しの機能を持っています。MATLAB エンジンによっ
てサポートされる ＭATLAB ワークスペースとのインターフェース機能は、
オフライン実験において利用することができます。

• Simulink® インターフェース によって、Simulink や Stateflow® で作成され
たモデルが ASCET にインポートされ、オフライン／オンライン実験にお
いて ETAS の実験ハードウェア上で実行することが可能となります。
Simulink モデルのインポートは、Real-Time Workshop® を使用してモデル
から C コードを生成すれば、それらが ASCET にモジュールとして自動的
に組み込まれます。モデルを実行するために必要なタスクとプロセスは、
ASCET 内で自動的に生成されます。

ASCET:

ASCET は、組み込み制御システム設計のための開発ツールです。主に自動車制御
の分野で活用され、オブジェクト指向によるデザインコンセプトを持ち、シミュ
レーションや、ターゲットシステム用のコード生成に至るまで、リアルタイムな
ソフトウェアシステム用の開発プロセスをトータルにサポートします。Hardware-
In-the-Loop（HIL) による検証が可能なため、システムの初期段階において制御ア
ルゴリズム（開ループあるいは閉ループアルゴリズム）をテストすることが可能
となります。これにより、新しいシステムの開発や既存のシステムの変更作業に
おいて、時間とコストの大幅な削減が実現されます。

MATLAB®/Simulink®:

MATLAB/Simulink プログラムパッケージは、2 つのコンポーネントから構成されま
す。ひとつは数学処理エンジンとプログラミング環境（MATLAB）で、もうひとつ
は数学モデルのグラフィック記述に関する処理を行う部分（Simulink）です。

Simulink の基本ブロックである MATLAB は、数学的問題に関する数値演算用に設
計されていて、主にマトリックスやベクトル演算が基本となっています。これら
のマトリックスやベクトル演算を制御するため、MATLAB の製造元である
MathWorks 社によって、関数と問題解析アルゴリズムによって機能拡張を行うた
めの言語が MATLAB に組み込まれました。MATLAB は科学や工業の分野で幅広く使
用されており、システム解析や制御エンジニアリング（線形／非線形システム、
ファジー制御など）の分野において、長年にわたり数多くの拡張機能が開発され
てきました。

Simulink は、ラプラス変換と Z 変換を利用した数学的モデルのグラフィック記述
をサポートします。MathWorks 社によって統合された基本ブロックライブラリを
使用して、たとえば基本ブロックのようなものを接続していくことによって、
データフローチャートの形式でモデルを構築することができます。Simulink の
オープンなアーキテクチャにより、カスタマイズしたブロックを追加して基本ブ
ロックを拡張することも可能です。非線形ダイナミックシステムのシミュレー
ションは、MATLAB により、数値計算機能と統合モデルを用いて実行されます。
はじめに 7
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Simulink には、モデルパラメータ用の変数をユーザー定義する機能があり、この
変数の値は MATLAB 内に保存されます。このように、変数の値をモデル記述とは
別に MATLAB（または *.mファイル）内に保存することにより、モデル記述とパ
ラメータ値との分離が可能となります。そのため、前もってさまざまな種類の
データセットを用意しておき、そのうちのいずれかを MATLAB 内にロードするこ
とによって、さまざまなデータセットをモデルに代入してシミュレーションする
ことが可能となります。

1.1 ユーザーズガイドについての注意点

このユーザーズガイドは、MATLAB/Simulink の数学モデルのモデリング機能を
ASCET と共に活用することを目標とする、組み込み制御システムの開発者を対象
としています。そのため、ここに説明されている内容をご理解いただくには、
MATLAB/Simulink や ASCET についての基本的な知識が必要です。これらの知識を
お持ちでない方は、最初に各ツールのユーザーズガイドやチュートリアルをお読
みいただくことをお勧めします。

1.2 ユーザーズガイドの構成

このマニュアルは、以下のように構成されています。

MATLAB インターフェースについては、第 2 章から第 6 章で説明されています。
第 2 章で概要、第 3 章で機能と基本操作を説明し、第 4 章でモデリングや実験を
行う際に MATLAB インターフェースを使用する方法について説明します。また API
インターフェースについては第 5 章に、トラブルシューティングについてのヒン
トの一覧は第 6 章にまとめられています。

Simulink インターフェースのシステムアーキテクチャ、表記方法、およびモデル
のインポートの操作に関しては、第 7 章で説明します。ここにはトラブルシュー
ティングについてのヒントの一覧も含まれています。

なお製品の最新バージョンに関する詳細な情報は、リリースノートをお読みくだ
さい。

1.3 表記上の規約規則

本書の表記は、以下の規約に従っています。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記
します。

OK をクリックして、... ユーザーインターフェース上のボタン
名は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。
はじめに



特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xx を参照
してください」の中の「xx」の部分）については、その参照先へのリンクが設け
られているので、必要な参照個所を素早く見つけることができます。

“Open File”ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログ
ボックス、入力フィールド等のタイト
ルは、“ ”で囲んで表記します。

setup.exeファイルを選択します。 リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字
列は、Courierフォントで表記しま
す。

論理型のデータから算術型のデータ
への変換はできません。

注意すべき個所、または新出の用語は
太字、あるいは「 」で囲んで表記され
ます。

OSEK グループ（http://www.osek-
vdx.org/ を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、青い下
線で表記されています。

注記

ユーザー向けの重要な注意事項

表記例 説明
はじめに 9
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2 MATLAB インターフェース － 概要

2.1 MATLAB インターフェースとは

MATLAB インターフェースは、ASCET と MATLAB 間のデータ交換を可能にします。
また、MATLAB 関数や MATLAB スクリプト（MATLAB の内部関数および M ファイ
ル）を ASCET 環境から呼び出すこともできます。さらには、ASCET と Simulink
モデル間の相互シミュレーションも、この MATLAB インターフェースによって実
現できます。

2.2 ASCET への MATLAB 関数の統合

MATLAB とのインターフェースにより、ASCET 開発環境での制御設計の解析工程
における相互作業が可能となります。また、MATLAB のすべての関数を ASCET

（データのポストプロセッシング、視覚化、ツールボックス等）と Simulink/
Stateflow（モデル統合）で利用することができます。
Matlab インターフェース － 概要 13
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3 MATLAB インターフェース － 機能

3.1 MATLAB API エンジンを利用した MATLAB - ASCET インターフェース

MIP は、MATLAB のプロセス間通信インターフェースである「MATLAB エンジン」
を基本としています。MATLAB エンジン は MATLAB と他のアプリケーションの間で
データを交換するための基本機能を持っています。MATLAB はリモート操作によっ
て起動されてサーバーとして機能し、リクエストを出すアプリケーション側がク
ライアントとなります。

MATLAB エンジン を使って、以下の処理が行えます。

• MATLAB プロセスのリモート起動と通信接続の確立

• MATLAB へのクライアントデータの送信

• クライアント環境での MATLAB データの受信

• MATLAB 関数のリモート実行

• 通常 MATLAB ワークスペース に表示されるタスクをテキストバッファに迂
回する処理

• MATLAB プロセスの終了と通信接続の切断

ASCET MATLABMIP
MATLAB 

???????

???????

???????

???????

MATLAB
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また、MIP は、接続の確立と切断、メモリの取得と解放、エラーの監視と対処、
および MATLAB ワークスペース 内の MATLAB データ構造体の生成（ASCET から行
う MATLAB 変数の定義）といった内部管理も分担します。これにより、ユーザー
や開発者が利用できる関数は C ソースコードで容易に組み込むことができるた
め、内部プロセスに関しての深い知識は特に必要ありません。

MIP には以下の C 関数が含まれています。

• MATLAB および通信パスを開く／閉じる：

- MIOpen,

- MIClose

• 実数データの送受信：

- MIPutMatrix, MIGetMatrix

- MIPutVector, MIGetVector,

- MIPutScalar, MIGetScalar,

- MIGetResult

• 複素数データの送受信：

- MIPutComplexMatrix, MIGetComplexMatrix,

- MIPutComplexVector, MIGetComplexVector,

- MIPutComplexScalar, MIGetComplexScalar,

- MIGetComplexResult

• 文字列変数の受信：

- MIGetString

• MATLAB インストラクション／関数／スクリプトの実行：

- MIExecute,

- MIExecuteAndEcho,

- MIExecuteWithourErrCheck

ASCET Matlab

Matlab

Matlab

Matlab
Matlab インターフェース － 機能 15
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• MATLAB データ構造体のチェック：

- MIIsReal,

- MIIsComplex,

- MIisEmpty,

- MIIsString,

- MIGetNRows,

- MIGetNCols

MIP 関数については、第 5 章「Matlab インターフェース － リファレンス」を参
照してください。なおその中には、通常は直接呼び出されることはなく、内部的
にのみ使用されるものも含まれています。

3.2 MATLAB インターフェースの応用

MIP を使えば、ASCET から MATLAB の全機能を利用できます。利用できる機能に
は、基本パッケージの基本関数、MATLAB ツールボックスのすべての関数、および
MATLAB M- ファイルの形式で作成されたすべてのユーザ定義関数などがあります。
Simulink モデルのシミュレーションを ASCET から開始することもできるので、
ASCET と Simulink の結合（コシミュレーション）が可能です（ただし、オンライ
ンのリアルタイム操作においては不可能です）。

以下に、MATLAB の応用例について概説します。

MATLAB － ASCET 間でデータ交換を行う

ASCET データは MATLAB に送信され、シミュレーションが中断されている間は、
MATLAB ワークスペース 内でデータの加工、演算の実行、データの視覚化などの
処理をマニュアル操作で行うことができます。必要に応じて ASCET はその計算結
果を MATLAB から受信し、シミュレーションの続行時にそれを使用することがで
きます。

ASCET Matlab

Matlab
 

...

M
 ...

PC
, P

PC
, 

PC
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MATLAB 関数を ASCET モデルに組み込む

ASCET でのシミュレーション実行中は、データは MATLAB に周期的に送信され、
リモート操作でリクエストされる MATLAB 関数によって自動的に処理されます。
データは、シミュレーションステップごとに 1 回ずつ MATLAB に転送したり、あ
るいは ASCET でバッファリングして、N ステップ分をデータパケットとしてまと
めて転送することもできます。シミュレーションは MATLAB からの処理結果が届
くまでは待ち状態となり、届いた結果に基づいて、たとえば ASCET のモデルパラ
メータの調整、といった処理を行い、その後、シミュレーションが続行されます。

Simulink モデルを ASCET モデルに組み込む

システムの一部、たとえばプラントモデルを MATLAB/Simulink で記述し、コント
ローラ部分を ASCET に実装します。Simulink モデルへの入力（つまりここではコ
ントローラ出力）は MATLAB に送信され、そのモデル用の積分ステップが
Simulink 内で実行されます。MATLAB から受け取った Simulink モデルからの出力

（プラントモデルからの出力）は ASCET モデル（コントローラ）に渡され、そこ
で次の積分ステップ用のコントロール値が算出されます。
Matlab インターフェース － 機能 17
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4 MATLAB インターフェース － ASCET からの呼び出し

MATLAB インターフェースの機能は、モデリングレベルにおいても実験レベルにお
いても利用できます。

モデリングレベルの場合、MATLAB へのリンクは ASCET 内の C コード、あるいは
連続系モデルの場合は C コードブロックの形で実現されます。これにより、
ASCET モデル内のどこでも MATLAB を使用でき、MATLAB 関数を API の形で
ASCET に直接組み込むことも可能です。

実験環境では、ASCET シミュレーションステップの前後で、MATLAB インター
フェース関数を周期的に実行することができます。これを行うためのウィンドウ
が提供されていて、その中に送受信する ASCET 変数のリストを登録することがで
きます。また別のリストに、MATLAB 内で実行される MATLAB 関数を登録すること
ができます。ただし、モデリングレベルでの C コードブロックの場合に比べて応
用範囲は限定されます。

4.1 モデリングレベル

一般に、MATLAB インターフェース関数の利用方法は、C コードブロック内で任意
に使用される C 関数を利用する場合と同じです。MIP は C ライブラリ（MATLAB

へのインターフェースを提供する DLL として実装されます）で、標準 C 言語に関
数を追加して機能を拡張する形をとっています。

4.1.1 ASCET 内での C コードブロック

ブロックの中には 2 つのメソッドを定義する必要があります。まず、初回にのみ
実行されるメソッドから MIOpen を呼び出し、MATLAB へのリンクを確立します。
ここでは必要に応じて、さらに MATLAB ワークスペース や ASCET に値のプリセッ
トを行うための関数を実行することもできます。そしてもう 1 つのメソッドに、
周期的な各種リクエスト（MATLAB へのデータ送信、MATLAB 関数の実行、データ
受信）を実行するコードを組み込みます。各メソッドの実行シーケンスは、モデ
ル全体として、シーケンスコールの形で適切に定義する必要があります。

1 つの ASCET モデルの中に MIP 関数を使用する C コードブロックが複数ある場
合でも、MIOpenを呼び出すのは 1 回だけです。必ず、最初に実行される MIP C
コードブロックが MIOpenコールを実行するようにしてください。また、複数の
C コードブロックで同名の MATLAB 変数を使用する場合には注意が必要です。す
べてのブロックが同じ MATLAB プロセスを使用して通信するため、使用される変
数はそれをコールする C コードブロック単体にリンクされるのではなく、モデル
全体に公開されてしまいます。
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4.1.2 C コードの CT ブロック

C コードで記述された MIP の CT ブロックは、固定的なメソッド群で構成されま
す。ASCET の C コードブロックの場合と同様に、init[]メソッドで MIOpen
リクエストを実行します。周期的に実行されるコードは、directOutputs[]
や update[]などのメソッド内に含めます。入出力は、適宜に定義します。

ASCET の C コードのクラスやモジュールの場合と同様、複数の C コードの CT ブ
ロックを使用する場合も MIOpen() のリクエストは一度だけでよく、MATLAB 
ワークスペース の変数はグローバルなアクセスが可能です。

4.2 実験レベル

C コードブロックに加え、ASCET にはもうひとつの MATLAB インターフェースが
あります。ASCET の実験環境の Matlab メニューによって、“Matlab Interface”
ダイアログウィンドウが開きます。このウィンドウから、MATLAB の起動や、コマ
ンドやデータの転送を行うことができます。
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4.2.1 データ転送と MATLAB ファンクションコール用のウィンドウ

ASCET の実験環境のメニューバーから Matlab → Open Interface を選択すると、
ツールボックスとしての機能を備えた“Matlab Interface”ウィンドウが開きま
す。

現バージョンでは、以下のボタンを使用できます（ボタンで実行されるアクショ
ンは、ボタン名の右に併記されているメニューコマンドによっても実行すること
もできます）。

1. Load Settings（メニューコマンド： File → Load Settings）
ファイルに保存されている MATLAB インターフェースウィンドウの設定

（ASCET ←→ MATLAB の変数割り当て、MATLAB ファンクションコール）を
ロードします。

2. Save Settings（メニューコマンド：File → Save Settings）
MATLAB インターフェースウィンドウの現在の設定をファイルに保存しま
す。

3. Save Settings As（メニューコマンド：File → Save Settings As）
MATLAB インターフェースウィンドウの現在の設定を、指定した名前の
データ形式で格納します。

4. Open Matlab（メニューコマンド：Matlab → Open Matlab）

MATLAB を起動して、通信を確立します。

5. Close Matlab（メニューコマンド：Matlab → Close Matlab）

MATLAB との通信を終了し、MATLAB をシャットダウンします。

1 2  3  4 5 6 7 8 9 10 11
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6. Stop Cyclic Transfer（メニューコマンド：Control → Stop Transfer）
ASCET から MATLAB へ、あるいは MATLAB から ASCET への周期的なデータ
転送を停止します。

7. Start Cyclic Transfer（メニューコマンド：Control → Start Transfer）
周期的なデータ転送を開始します。これを行うには、シミュレーションが
あらかじめ実行されている必要があります。変数割り当てリストに登録さ
れている変数の値が ASCET 内で集められ、指定のシミュレーションス
テップ数が経過した後に、ASCET から MATLAB へ、あるいは MATLAB から
ASCET へ転送されます。データ転送ブロックのサイズは、MATLAB イン
ターフェースウィンドウの“Package Size”という入力フィールドで指定
します。

“MATLAB Function Calls”フィールドに指定された MATLAB アクション
は、MATLAB へのデータ転送終了後に実行されます。

以下のボタンは、マニュアル操作による MATLAB とのデータ送受信に使用します。
ウィンドウのメニューには、これらのボタンに相当するメニューコマンドはあり
ません。

8. Init To Matlab

“ToMatlab”タブ内の Init属性を持つ変数アクションあるいは MATLAB

ファンクションコールを実行します。

9. Send To Matlab

ASCET から MATLAB への転送を実行します。これは、“To Matlab”タブに
入力されたすべての ASCET → MATLAB 変数割り当てが対象となります。変
数の転送が終わると、“Matlab function calls”フィールドに入力されてい
る MATLAB コマンドが順に実行されます。

10. Init From Matlab

“From Matlab”タブ内の Init 属性を持つ変数のアクションあるいは
MATLAB ファンクションコールが実行されます。

11. Receive From Matlab

MATLAB から ASCET への転送を実行します。これは、“From Matlab”タブ
に入力されたすべての ASCET ← MATLAB 変数割り当てが対象となります。

“Matlab function calls”フィールドに入力されている MATLAB コマンドが
順に実行された後、変数が MATLAB から ASCET へ転送されます。

ボタンで操作されるすべてのコマンドやアクションは、ウィンドウのメニューに
よっても操作することができます。

ASCET 変数を“To Matlab”と“From Matlab”の 2 つのタブの変数フィールドに
割り当てるには、ドラッグ＆ドロップ機能を利用ことができます。デフォルトで
は、ASCET の変数名はそのまま MATLAB の変数名として使用することができます

注記

上記の内容は、ToMatlab メッセージと FromMatlabメッセージの両方に当
てはまります。
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が、デフォルトの MATLAB 変数名がバックスラッシュ（“￥”）を含んでいる場合
は ASCET では使用できないので、変数名をダブルクリックしてマニュアル操作で
修正してください。

MATLAB ファンクションコールの記述を行うには、メニューコマンド Edit →
Function Calls → Add Function Call、あるいは“Matlab Function Call”フィー
ルドをマウスで右クリックして表示されるショートカットメニューの Add 
Function Call を選択します。init、cyclic、disabled というプロパティを関数と変
数に割り当てます。init プロパティが割り当てられた変数とファンクションコール
は、MATLAB インターフェースが開いた直後に 1 回だけ、あるいは Init To Matlab 
(8) や Init From Matlab (10) ボタンが押された時に、転送あるいは実行されます。

MATLAB とのデータ交換はブロック単位で行われます。つまり、タスクが実行され
た後に各出力信号はバッファに書き込まれ、バッファがフルになった時点で
MATLAB への転送が開始されます。この Package Size は任意に変更できます。

データを転送する際は、すでに ASCET の実験ウィンドウからシミュレーションが
開始されている必要があります。ボタン 4 および 7 によって、MATLAB に転送す
るデータの収集が開始されます。Package Size に指定された量のデータが蓄積さ
れると直ちにパッケージが MATLAB に送信され、次に、Function Calls リストが実
行されます。このようにして、ASCET から MATLAB への転送データ（“To Matlab”
タブ）の送信、MATLAB でのアクション実行、そして MATLAB から ASCET への転
送データ（“From Matlab”タブ）の受信、という順で処理が行われます。

4.2.2 MATLAB とのデータ送受信

変数 : MATLAB に送信される変数や、MATLAB プログラムから受信する変数の名
前は、“To Matlab”タブの“ASCET Variable → Matlab Variable”フィールド、ま
たは“From Matlab”タブの“ASCET Variable ← Matlab Variable”フィールドに
入力します。

変数は、ASCET 実験環境からドラッグ & ドロップ で“To MATLAB”タブに追加
できます。またあるいは、“Matlab Interface”ダイアログの変数フィールドでマ
ウスの右ボタンをクリックして表示されるショートカットメニューで Add 
Element を選択すると、ASCET 変数が選択ボックスに表示されます。
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ここでは複数の変数を選択することが可能です。必要な変数をすべて選択し、OK
ボタンで確定します。

選択された ASCET 変数が、“To Matlab”タブの“ASCET Variable → Matlab 
Variable”フィールドに表示されます。割り当てられた MATLAB 変数は、デフォル
トでは ASCET 変数と同じ名前になります。

MATLAB でのデフォルト名は、‘¥' や‘/' が‘_' に置き変わる以外は、ASCET で
の名前と同じです。MATLAB 変数名を変更するには、変更したい変数をダブルク
リックしてから、新しい名前を入力します。

この例では、ASCET 変数の air_lowが MATLAB 変数 myname に割り当てられて
います。air_low¥test_class_C_1という名前は、変数 asd_aの内部名で
す。

各変数には、メニューコマンド Edit → Element、またはショートカットメニュー
で、 Init、Cyclic、Disabled のいずれかの属性を割り当てることができます。この
属性によって、その変数を転送するかしないか、あるいは最初に一度だけ転送す
るかどうかが決まります。
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• Init：

変数の値は、シミュレーション開始時に一度だけ、自動的に MATLAB に転送
されます。

• Cyclic：

変数の値が転送されます。

• Disabled：

変数の値は転送されません。

“From Matlab”タブの“ASCET Variable ← Matlab Variable”フィールドに
MATLAB から受信されるデータアイテムを割り当てる際も、上記の方法と同じ方法
で行います。

4.2.3 MATLAB 関数の実行

“To Matlab”および“From Matlab”タブ上の MATLAB コマンドリストには、それ
ぞれもう 1 つのリストが付随しています。そのリストの中には、MATLAB へ変数を
送信した後、あるいは MATLAB から変数を受信する前に実行される MATLAB 関数
を、その転送パラメータとともに登録します。登録された関数は変数に直接割り
当てられるのではなく、データ送信と受信との間に関数リストとして実行されま
す。ここでもやはり、ファンクションコールに属性を割り当てて、コールの実行
について明確に定義することができます（22 ページの「変数」 を参照してくださ
い。）

• Cyclic / Disabled：

実行を許可／不許可にします。

• Init：

MATLAB との接続確立時に一度だけ実行されます。

MATLAB ファンクションコールの追加は、 以下のように行います。
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MATLAB ファンクションコールを追加する：

• “Matlab Function Calls”リストエリアを右クリッ
クして、ショートカットメニューから Add 
Function Call を選択します。

選択が完了すると、ファンクションコールの標準
エントリが作成されてリスト内に表示されます。
下図は、デフォルトのファンクションコールが新
たに追加された状態を示しています。

• 新しく作成されたファンクションコールのデフォ
ルト名を変更するには、そのファンクションコー
ルをダブルクリックしてから新しい名前を入力し
ます。
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ここでは、有効な MATLAB コールやコマンドのすべてを使用できます。以下の例
では、2 つの MATLAB ファンクションコールが使用されています。

MATLAB ファンクションコールは、“To Matlab”タブおよび“From Matlab”タブ
上で、互いに独立して指定することができます。Start ボタン（7）で周期的な
データ転送を開始すると、“To Matlab”タブに指定された変数が転送され、“To 
Matlab”タブの MATLAB ファンクションコールが実行されます。続いて“From 
Matlab”タブの MATLAB ファンクションコールが実行され、最後に“From 
Matlab”タブの変数が転送されます。

すべての MATLAB 関数（*.mファイル）をファンクションコールとして使用する
ことができます。その場合、変数名の対応と MATLAB スクリプトの妥当性は、
ユーザーの責任において管理する必要があります。

4.2.4 重複時の対処

リスト内の複数の変数に同じ属性が与えられている場合、リスト内で上位にある
変数／関数が先に処理されます。

注記

ウィンドウ内の Start と Stop ボタンは、ASCET 実験のシミュレーションの実行
には影響せず、データ転送制御にだけ影響します。
ASCET シミュレーションの制御は、“Physical Experiment”ウィンドウのボタン
あるいはメニューから行います。
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5 MATLAB インターフェース － リファレンス

5.1 プロセス間通信

本項で紹介する関数を使って、MATLAB プロセスのリモート起動や、MATLAB への
通信リンクの開始／終了が行えます。

MIExecute、MIExecuteAndEcho、および MIExecuteWithoutErrCheck
は、MATLAB 関数をリモートで呼び出して実行するための関数です。これらの関数
を使って MATLAB の全機能を利用することができます。

MIExecuteおよび MIExecuteAndEchoは MATLAB の内部エラーのチェックと
エラー処理を行います。このエラー処理では、MIExecuteWithoutErrCheck
が重要な役割を果たします（詳細は、5.6 章「エラー処理」を参照してくださ
い。）。

MIExecuteWithoutErrCheck を使用することは避けてください。。

エラー処理の手続き上、MATLAB エンジンによって提供される MIExecute、およ
び MIP関数の MIActivateBuffer（5.7 章「内部関数」および『MATLAB API 
Guide』を参照してください）を実行した際、文字バッファ内に格納された
MATLAB 出力を応答として読み取ることは、事実上行えません。代わりに
MIExecuteAndEcho を使用してください。

5.1.1 MIOpen

構文：

bool MIOpen( void )

引数：

なし。

成功すれば trueを、そうでなければ falseを返します。

機能：

MATLAB プロセスを開始し、MATLAB への通信リンクを確立します。

例：

ok = MIOpen();

参照：

→ "MIClose"
Matlab インターフェース － リファレンス 27



28
5.1.2 MIClose

構文：

bool MIClose( void )

引数：

なし。

成功すれば trueを、そうでなければ falseを返します。

機能：

実行していた MATLAB プロセスを終了し、接続を切断します。

例：

ok = MIClose();

参照：

→ "MIOpen"

5.1.3 MIExecute

構文：

bool MIExecute( char *evalstring )

引数：

機能： 

evalstringは、MATLAB で実行される MATLAB コードが格納された文字列で、
この関数には MATLAB の任意の式または文を記述できます。MIExecuteは
MATLAB 環境内でエラーが発生したかどうかを調べ、エラーが検出されるとエラー
メッセージを発行します。

成功すれば trueを返し、そうでなければ falseを返します。

例：

/* MATLABの図中に正弦波を描画します。 */

MIExecute("t = 0:0.01:5");

MIExecute("f = 2.7818");

MIExecute("y = sin(2*pi*f*t)");

MIExecute("plot(t, y, 'r')");

/* my_MATLAB_function.mという M-ファイルに定義されている */

evalstring 文字列
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/* ユーザ定義の MATLAB関数を実行します。 */

MIExecute("out = my_Matlab_function(arg1, arg2, argN)");

参照：

→ "MIExecuteAndEcho"

5.1.4 MIExecuteAndEcho

構文：

bool MIExecuteAndEcho( char *evalstring, 

char *buffer )

引数：

機能：

MIExecute()と同様ですが、バッファ bufferに MATLAB 出力をエコーしま
す。

注意：

buffer として宣言されているサイズよりも MATLAB 出力の実際のサイズの方が
大きいと、システムクラッシュが発生します。

成功すれば trueを、そうでなければ falseを返します。

例：

char outputBuffer[1024];

MIExecuteAndEcho("A = [1 2;-3 -4 ]; eig(A)",

outputBuffer);

printf("Eigen values of A: ¥n %s¥n", 

outputBuffer);

参照：

→ "MIExecute"

evalstring 文字列

buffer 文字列
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5.1.5 MIExecuteWithoutErrCheck

構文：

bool MIExecuteWithoutErrCheck( char *evalstring )

引数：

機能：

この関数の機能は MIExecuteと同様ですが、MATLAB 環境で発生するエラーは
チェックされません。MIExecuteWithoutErrCheckは、MATLAB コードに
まったくエラーがないことが確認できていて、さらに実行時エラーが起こっても
それほど重大な事態にはならない場合に限り使用するようにしてください。エ
ラーチェックを行う場合よりも短い時間で実行できるので、実行時間を短縮でき
る場合があります。

例：

/* 以下のコマンドを実行して、2 つの関数の相違を比べてみます。*/

/*　Aは 3× 2のマトリックスですが、*/

/*　行列式（determinant）は正方行列しか */

/*　サポートしていないので、bを算出しようとすると */

/*　MATLABエラーになります。*/

/* エラーチェックは行われないので、 */

/* エラーメッセージは表示されません。*/

MIExecuteWithoutErrCheck

   ("A = [1 2 3; 4 5 6]; b = det(A);");

 

/* エラーメッセージウィンドウが表示され、*/

/* MATLABエラーメッセージが表示されます。*/

MIExecute("A = [1 2 3; 4 5 6]; b = det(A);");

参照：

→ "MIExecute"

evalstring 文字列
Matlab インターフェース － リファレンス



→ "MIExecuteAndEcho"

5.2 データ管理

ASCET で扱えるデータ型は、実数のスカラ、ベクトル（array）、およびマト
リックスのみですが、MATLAB では他にいくつかのデータ型を利用できます。

送受信の処理ができるのは、C 言語で記述された倍精度型のスカラと配列（ベク
トルとマトリックスを含みます）だけです。

MATLAB で算出された複素数を扱うためには、データの実数部分と虚数部分を別の
変数として送受信する必要があります。MATLAB ワークスペース 内では、複素数
データは 1 つの構造体として表現されています。

MI 関数に渡される引数は倍精度のスカラまたは配列を参照するポインタです。そ
のため、使用する変数用のメモリを確保したり解放したりする処理が必要です。
これは明示的な C コードの外部に ASCET クラス変数を定義するか、あるいはその
変数のスコープが C コードのクラス／ CT ブロックに限られている場合には後述
の関数を呼び出すことによって行うことができます。

5.2.1 MICreateDouble

構文：

MICreateDouble( aVarName, nElements )

注記

MATLAB コードのエラーなどによってランタイムエラーが発生すると、その次に
実行された以下のいずれかの関数のエラーとして通知されます。

MIExecute(), MIExecuteAndEcho(),
MIGetComplexMatrix(),MIGetComplexResult(),
MIGetComplexScalar(),MIGetComplexVector(),
MIGetMatrix(), MIGetNCols(),
MIGetNRows(), MIGetResult(),
MIGetScalar(), MIGetString,
MIGetVector()

注記

MI 関数名や本書で、「ベクトル」という語は、ASCET の配列（array）型、お
よびそれに対応する MATLAB 構造体に対して使用されています。
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引数：

機能：

MICreateDoubleは、すでに宣言されている double型変数 aVarNameの
nElements個分のメモリを確保するマクロです。

確保したメモリは、MIDestructDoubleを実行して解放してください。

例：

double *aVariable;

MICreateDouble(aVariable, 9);

MIExecute("A=magic(3);");

MIGetMatrix(aVariable, "A");

MIDestructDouble(aVariable);

参照：

→ "MIDestructDouble"

5.2.2 MIDestructDouble

構文：

MIDestructDouble( aVarName )

引数：

機能：

MIDestructDoubleは、参照される変数 aVarNameに割り当てられているメ
モリを解放します。メモリは、MICreateDoubleを実行することによって割り
当てられています。

例：

MICreateDouble(aVariable,9);

...

aVarName 変数の名前

nElements 確保するエレメントの数

aVarName 変数の名前
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MIDestructDouble(aVariable);

参照：

→ "MICreateDouble"

5.3 MATLAB へのデータ送信

本項で紹介する関数は、MATLAB ワークスペース へのデータ送信（put）処理をサ
ポートします。実数データと複素数データの転送は、それぞれ別の関数で行われ
ます。送信できるのは、マトリックス、ベクトル、およびスカラのデータに限ら
れ、それらに対応する MATLAB データ構造体が MATLAB 環境内に作成されます。使
用できるデータ型についての詳細は、データ管理の章を参照してください。

5.3.1 MIPutMatrix

構文：

bool MIPutMatrix( char *MatlabVarName, 
double *rVar, 
int nRows, 
int nCols )

引数：

機能：

MATLAB にマトリックスデータを送信し、MatlabVarNameで指定された変数に
代入します。rVarにより参照されるデータは double型でなければなりません。
nRowsと nColsは、MATLAB ワークスペース 内に作成されるベクトルのサイズ
を示します。

成功すれば trueを、そうでなければ falseを返します。

例：

/* データの定義 */

double rdata[] = {0, 1, 1, 2, 3, 5, 8, 13, 21, 34};

/* rdataを送信し、 */

/* MATLAB変数 Fiboに代入します。 */

MatlabVarName データが代入される MATLAB 変数の名前

rVar 転送される実数へのポインタ

nRows データが代入される MATLAB マトリックスの行数

nCols データが代入される MATLAB マトリックスの列数
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MIPutMatrix("Fibo", rdata, 2, 5);

Matlab ワークスペース 内では：

% Fibo は 5x2のマトリックスです。

>> Fibo =

0   1   3   8   21

1   2   5  13   34

参照：

→ "MIPutVector"

→ "MIPutScalar"

→ "MIPutComplexMatrix"

→ "MIPutComplexVector"

→ "MIPutComplexScalar"

5.3.2 MIPutScalar

構文：

bool MIPutScalar( char *MatlabVarName, 
double *rVar )

引数：

機能：

MATLAB にスカラデータを送信し、MatlabVarNameで指定された変数に代入し
ます。rVarにより参照されるデータは double型でなければなりません。内部
的には、この関数は受け取った引数を nRows = 1および nCols = 1という固
定パラメータとともに、関数 MIPutMatrixに渡します。

成功すれば trueを、そうでなければ falseを返します。

例：

/* データの定義 */

double realScalar = 5; 

/* realScalarを送信し、*/

/* MATLAB変数 xに代入します。*/

MatlabVarName データが代入される MATLAB 変数の名前

rVar 転送される実数データへのポインタ
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MIPutScalar("x", &realScalar);

参照：

→ "MIPutMatrix"

→ "MIPutVector"

→ "MIPutComplexMatrix"

→ "MIPutComplexVector"

→ "MIPutComplexScalar"

5.3.3 MIPutVector

構文：

bool MIPutVector( char *MatlabVarName,
double *rVar, 
int nRows )

引数：

機能：

MATLAB に配列データを送信し、MatlabVarNameで指定された変数に代入しま
す。rVarにより参照されるデータは double型でなければなりません。nRows
は、MATLAB ワークスペース 内に作成されるベクトルの要素数を示します。この
関数は受け取った引数を nCols = 1という固定パラメータとともに、関数
MIPutMatrixに渡します。

成功すれば trueを、そうでなければ falseを返します。

例：

/* データの定義 */

double rdata[] = {0, 1, 1, 2, 3, 5, 8, 13, 21,34};

/* rdataを送信し、*/

/* MATLAB変数 Fibに代入します。*/

MIPutVector("Fib", rdata, 10);

Matlab ワークスペース 内では：

MatlabVarName データが代入される MATLAB 変数の名前

rVar  転送される実数データへのポインタ

nRows データが代入される MATLAB ベクトルの行数
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% Fibはエレメント数が 10の列ベクトルです。

Fib = 

0

1  

1  

2  

3  

5  

8  

13 

21  

34

参照：

→ "MIPutMatrix"

→ "MIPutScalar"

→ "MIPutComplexMatrix"

→ "MIPutComplexVector"

→ "MIPutComplexScalar"

5.3.4 MIPutComplexMatrix

構文：

bool MIPutComplexMatrix(char *MatlabVarName,
double *varReal, 
double *varImag, 
int nRows, 
int nCols )
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引数：

機能：

MATLAB に 2 つの配列データを送信し、MatlabVarNameで指定された変数の実
数部分と虚数部分に代入します。nRowsと nColsは、MATLAB ワークスペース 
内に作成されるベクトルのサイズを示します。

成功すれば trueを、そうでなければ falseを返します。

例：

double outReal[] = {2, 3, 5, 7};

double outImag[] = {11, 13, 17, 19};

/* varRealおよび varImagのデータを送信し、*/

/* MATLAB変数 Cに代入します。*/

MIPutComplexMatrix("C", outReal, outImag, 2, 2);

Matlab ワークスペース 内では：

>> C =

2 + 11i 5 + 17i

3 + 13i 7 + 19i

参照：

→ "MIGetComplexResult"

→ "MIPutComplexVector"

→ "MIPutComplexScalar"

→ "MIGetComplexMatrix"

→ "MIGetComplexVector"

→ "MIGetComplexScalar"

MatlabVarName データが代入される MATLAB 変数の名前

varReal 転送されるデータの実数部分へのポインタ

varImag 転送されるデータの虚数部分へのポインタ

nRows データが代入される MATLAB マトリックスの行数

nCols データが代入される MATLAB マトリックスの列数
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5.3.5 MIPutComplexScalar

構文：

bool MIPutComplexScalar(char *MatlabVarName, 
double *varReal, 
double *varImag )

引数：

機能：

2 つのスカラ（1 つが実数部分を表し、もう 1 つが虚数部分を表す）で表現され
る複素数のスカラデータを MATLAB に送信し、MatlabVarNameで指定された変
数の実数部分と虚数部分に代入します。内部的には、この関数は渡された引数を
nRows = 1および nCols = 1という固定的なパラメータとともに、関数
MIPutComplexMatrixに渡します。

成功すれば trueを、そうでなければ falseを返します。

例：

double scalarReal = 1;

double scalarImag = -4;

/* scalarRealおよび scalarImagのデータを送信し、*/

/* MATLAB変数 Eに代入します。*/

MIPutComplexScalar("E", &scalarReal, 

&scalarImag);

参照：

→ "MIGetComplexResult"

→ "MIPutComplexMatrix"

→ "MIPutComplexVector"

→ "MIGetComplexMatrix"

→ "MIGetComplexVector"

→ "MIGetComplexScalar"

MatlabVarName データが代入される MATLAB 変数の名前

varReal 転送されるデータの実数部分のポインタ

varImag 転送されるデータの虚数部分のポインタ
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5.3.6 MIPutComplexVector

構文：

bool MIPutComplexVector(char *MatlabVarName, 
double *varReal,
double *varImag, 
int nRows )

引数：

機能：

2 つの配列で表現される複素数のベクトルデータを MATLAB に送信し、
MatlabVarNameで指定された変数の実数部分と虚数部分に代入します。nRows
は、MATLAB ワークスペース 内に作成される配列のサイズを示します。内部的に
は、この関数は渡された引数を nCols = 1という固定パラメータとともに、関
数 MIPutComplexMatrixに渡します。

成功すれば trueを、そうでなければ falseを返します。

例：

double outReal[] = {2, 3, 5, 7};

double outImag[] = {11, 13, 17, 19};

/* outRealおよび outImagのデータを送信し、*/

/* MATLAB変数 Cに代入します。*/

MIPutComplexVector("C",  outReal, outImag, 4);

参照：

→ "MIGetComplexResult"

→ "MIPutComplexMatrix"

→ "MIPutComplexScalar"

MatlabVarName データが代入される MATLAB 変数の名前

varReal  転送されるデータの実数部分へのポインタ

varImag  転送されるデータの虚数部分へのポインタ

nRows データが代入される MATLAB マトリックスの行数
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5.4 MATLAB からのデータ受信

本項では、MATLAB ワークスペース からデータを受信（get ）する方法について説
明します。2 種類のデータ転送方法があり、渡される引数の型は、以下に述べる
ようにそれぞれ異なります。引数の型の整合性がとれていないと、システムが予
期しない動作をしたり、プロセスが終了（システムクラッシュ）してしまう可能
性があります。

MIGetResult、MIGetComplexResult

MATLAB は、転送されたデータを MATLAB 固有の C 構造体として格納するためのメ
モリ領域を共有メモリ内に自分自身で確保するので、MIGetResultおよび
MIGetComplexResult関数実行時には、データを格納するためのメモリを確保
する必要がありません。データを転送するために 2 つのメソッドが提供されてい
ます。2 つのメソッドは引数が異なり、引数が正しく指定されていないと、シス
テムが予期しない動作をしたり、プロセスが終了（システムクラッシュ）してし
まう可能性があります。

MIGetMatrix、MIGetVector、MIGetScalar、MIGetComplexMatrix など

これらの関数では、関数の引数用のメモリに MATLAB 構造体のデータが明示的に
コピーされるので、あらかじめメモリを確保しておく必要があります。

内部的には主に MIGetString が使用されますが、これは無制限に使用できます。

5.4.1 MIGetResult

構文：

bool MIGetResult( double **result,

char *MatlabVarName )

引数：

機能：

MATLAB ワークスペース から ASCET 環境へデータを転送します。

resultは、受信データを参照する doubleのポインタへのポインタです。すで
に MATLAB がデータ用のメモリを確保しているので、この関数を使用する前に
MICreateDoubleを実行する必要はありません。

MatlabVarNameは転送されるデータの MATLAB 変数名が格納されている文字列
です。MATLAB 変数は 2 次元マトリックス、ベクトル、あるいはスカラでなければ
なりません。resultの型、ディメンション、サイズを調べるには、
"MIIsReal"、"MIGetNRows"、"MIGetNCols" を使用してください。

result double 型へのポインタを参照するポインタ

MatlabVarName 文字列
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MIGetResultは参照される MATLAB 変数の実数部分だけを転送します。複素数
の転送については、"MIGetComplexResult"を参照してください。

成功すれば trueを、そうでなければ falseを返します。

例：

double *in;

MIExecute("A = [1 2; -3 -4]; e = eig(A);");

MIGetResult(&in, "e");

参照：

→ "MIGetComplexResult"

→ "MIGetMatrix"

→ "MIGetVector"

→ "MIGetScalar"

→ "MIGetString"

→ "MIGetNRows"

→ "MIGetNCols"

→ "MIIsReal"

→ "MIIsComplex"

→ "MIIsEmpty"

5.4.2 MIGetMatrix

構文：

bool MIGetMatrix( double *in, char *MatlabVarName )

引数： 

機能：

MATLAB ワークスペース から ASCET 環境へ、マトリックスを転送します。

inは、double 型の受信データへのポインタです。参照する ASCET マトリック
スがまだ宣言されていない場合、この関数を実行するためには、
MICreateDoubleを実行して受信データ用に十分なメモリを確保しておく必要
があります。

in double 型へのポインタ

MatlabVarName  文字列
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MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数は適切なサイズの 2 次元マトリックスでなければなり
ません。inの型、ディメンション、サイズを調べるには、"MIIsReal"、
"MIGetNRows"、"MIGetNCols"を使用してください。

MIGetMatrixは参照される MATLAB 変数の実数部分だけを転送します。複素数
型のマトリックスを転送する場合は、"MIGetComplexMatrix"を参照してく
ださい。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdMatrixは、Cコードクラスの */

/* エレメントリスト内で宣言されている */

/* ユーザー定義の ASCET変数です。*/

MIExecute("A = magic(3);");

MIGetMatrix(asdMatrix, "A");

例 2：

/* inはユーザー定義のローカル変数で、*/

/* ASCET で見ることはできません。*/

/* そこで、そのためのメモリを */

/* 確保する必要があります !*/

double *in;

MICreateDouble(in, 9);

MIGetMatrix(in, "A");

MIDestructDouble(in);

参照：

→ "MIGetComplexMatrix"

→ "MIGetVector"

→ "MIGetScalar"

5.4.3 MIGetVector

構文：

bool MIGetVector( double *in,
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char *MatlabVarName )

引数： 

機能：

MATLAB ワークスペース からユーザー環境へ、ベクトルを送信します。

inは、double 型への受信データへのポインタです。参照する ＡSCET 配列がま
だ宣言されていない場合、この関数を実行するためには、( MICreateDouble
を実行して受信データ用に十分なメモリを確保しておく必要があります。

MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数は適切なサイズのベクトルでなければなりません。in
の型とサイズを調べるには、"MIIsReal"、"MIGetNRows"、"MIGetNCols"
を使用してください。

MIGetVectorは参照される MATLAB 変数の実数部分だけを転送します。複素数
型のベクトルを転送する場合は、"MIGetComplexVector"を参照してくださ
い。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdArrayは、Cコードクラスエレメントリスト内で */

/* 宣言されているユーザー定義の */

/* ASCET変数です。*/

MIExecute("randomVec = rand(9,1);");

MIGetVector(asdArray, "randomVec");

例 2：

/* inはユーザー定義のローカル変数で、*/

/* ASCETで見ることはできません。*/

/* そこで、ユーザーはそのためのメモリを */

/* 確保する必要があります !　*/

double *in;

MICreateDouble(in, 9);

in double 型へのポインタ

MatlabVarName  文字列
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MIExecute("randomVec = rand(9,1);");

MIGetVector(in, "randomVec");

MIDestructDouble(in);

参照：

→ "MIGetComplexVector"

→ "MIGetMatrix"

→ "MIGetScalar"

5.4.4 MIGetScalar

構文：

bool MIGetScalar( double *in,

char *MatlabVarName )

引数： 

機能：

MATLAB ワークスペース から ASCET 環境へ、スカラデータを送信します。

inは、double型の受信データを参照するためのポインタです。

MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数はスカラでなければなりません。

MIGetScalarは参照される MATLAB 変数の実数部分だけを転送します。複素数
型のスカラを転送する場合は、"MIGetComplexScalar"を参照してください。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdContは、Cコードクラスエレメントリスト内で */

/* 宣言されているユーザー定義の */

/* ASCET 変数です */

MIExecute("MATLABVar = pi;");

MIGetScalar(&asdCont, "MablabVar");

in double 型へのポインタ

MatlabVarName  文字列
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例 2：

/* inはユーザー定義のローカル変数で、*/

/* ASCETで見ることはできません。*/

/* しかしスカラの場合は、明示的にメモリを */

/* 確保する必要はありません ! */

double *inVar;

MIExecute("MATLABVar = pi;");

MIGetScalar(&inVar, "MATLABVar");

参照：

→ "MIGetComplexScalar"

→ "MIGetMatrix"

→ "MIGetScalar"

5.4.5 MIGetComplexResult

構文：

bool MIGetComplexResult(double **inReal, 

double **inImag,

char *MatlabVarName )

引数：

機能：

MATLAB ワークスペース からユーザー環境へ複素数データを転送します。

inReal および inImagは、すでに内部的にメモリ確保されている受信データの
実数部分と虚数部分を参照するためのポインタです。ですからさらにメモリを確
保する必要はありません。

MatlabVarNameは転送されるデータの MATLAB 変数名が格納されている文字列
です。受信データの型は doubleです。MATLAB 変数は 2 次元マトリックス、ベ
クトル、あるいはスカラのうちのいずれかです。

inReal double 型へのポインタを参照するポインタ

inImag double のポインタへのポインタ

MatlabVarName 文字列
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MatlabVarNameの型、ディメンション、サイズを調べるには、"MIIsReal"、
"MIGetNRows"、"MIGetNCols"を使用してください。

成功すれば trueを、そうでなければ falseを返します。

例：

/* MATLAB変数 EigenValueを、*/

/* 型をチェックしてから受信します。*/

double *inReal, *inImag;

MIExecute("EigenValue = eig[1 2; -3 4])";);

if (MIIsComplex("EigenValue"))

MIGetComplexResult(&inReal, &inImag, "EigenValue");

else

printf("Referenced variable is not 

complex!¥n");

参照：

→ "MIIsComplex"

5.4.6 MIGetComplexMatrix

構文：

bool MIGetComplexMatrix(double *inReal, 
double *inImag, 
char *MatlabVarName )

引数： 

機能：

MATLAB ワークスペース から ASCET 環境へ、複素数型マトリックスを転送しま
す。

inReal double 型へのポインタ

inImag double 型へのポインタ

MatlabVarName  文字列
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inReal と inImagは、受信データを参照するために使用される 2 つの double
型データへのポインタです。参照する ASCET マトリックスがまだ宣言されていな
い場合、この関数を実行するためには、MICreateDoubleを実行して受信デー
タ用に十分なメモリを確保しておく必要があります。

MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数は適切なサイズの 2 次元マトリックスでなければなり
ません。inの型、ディメンション、サイズを調べるには、"MIIsComplex"、
"MIGetNRows"、"MIGetNCols" を使用してください。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdMatrixReal、asdMatrixImagは、　*/

/* Cコードクラスエレメントリスト内で宣言されている、*/

/* ユーザー定義の ASCET変数です。*/

MIExecute("[A, v] = eig([1 2; -3 4]);");

MIGetComplexMatrix(asdMatrixReal, asdMatrixImag, "A");

例 2：

/* inRealおよび inImagは */

/* ユーザー定義のローカル変数で、 */

/* ASCETで見ることはできません。*/

/* ですから、ユーザーはそのためのメモリを */

/* 確保する必要があります ! */

double *inReal, *inImag;

MICreateDouble(inReal, 4);

MICreateDouble(inImag, 4);

MIExecute("[A, v] = eig([1 2; -3 4]);");

MIGetComplexMatrix(inReal, inImag, "A");

MIDestructDouble(inReal);

MIDestructDouble(inImag);
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参照：

→ "MIGetMatrix"

→ "MIGetComplexVector"

→ "MIGetComplexScalar"

5.4.7 MIGetComplexVector

構文：

bool MIGetComplexVector(double *inReal, 

double *inImag, 

char *MatlabVarName )

引数： 

機能：

MATLAB ワークスペース から ASCET 環境へ、複素数型ベクトルを転送します。

inRealと inImag は、受信データを参照するために使用される 2 つの double
型データへのポインタです。参照する ASCET 配列がまだ宣言されていない場合、
この関数を実行するためには、MICreateDoubleを実行して受信データ用に十
分なメモリを確保しておく必要があります。

MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数は適切なサイズのベクトルでなければなりません。in
の型、ディメンション、サイズを調べるには、"MIIsComplex"、
"MIGetNRows"、"MIGetNCols"を使用してください。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdVectorReal、asdVectorImagは、Cコードクラスの */

/* エレメントリスト内で宣言されている、*/

/* ユーザー定義の ASCET変数です。*/

MIExecute("A = eig([1 2; -3 4]);");

MIGetComplexVector(asdVectorReal,

inReal double 型へのポインタ

inImag double 型へのポインタ

MatlabVarName  文字列
Matlab インターフェース － リファレンス



asdVectorImag,"A");

例 2：

/* inRealおよび inImagは */

/* ユーザー定義のローカル変数で、*/

/* ASCETで見ることはできません。*/

/* そこで、ユーザーはそのためのメモリを */

/* 確保する必要があります ! */

double *inReal, *inImag;

MICreateDouble(inReal, 2);

MICreateDouble(inImag, 2);

MIExecute("A = eig([1 2; -3 4]);");

MIGetComplexVector(inReal, inImag, "A");

MIDestructDouble(inReal);

MIDestructDouble(inImag);

参照：

→ "MIGetVector"

→ "MIGetComplexMatrix"

→ "MIGetComplexScalar"

5.4.8 MIGetComplexScalar

構文：

bool MIGetComplexScalar(double *inReal, 
double *inImag, 
char *MatlabVarName )
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引数：

機能：

MATLAB ワークスペース からユーザー環境へ、複素数型スカラデータを転送でき
ます。

inRealと inImag は、受信データを参照するために使用される 2 つの double
型データへのポインタです。

MatlabVarNameは、転送されるデータの MATLAB 変数名が格納されている文字
列です。この MATLAB 変数はスカラでなければなりません。型を調べるには
MIIsComplexを使用してください。

成功すれば trueを、そうでなければ falseを返します。

例：

例 1：

/* asdScalarReal、asdScalarImagは、*/

/* Cコードクラスのエレメントリスト内で宣言されている、*/

/* ユーザー定義の ASCET変数です。*/

MIExecute("v = 3 - 4i;");

MIGetComplexScalar( &asdScalarReal, 
&asdScalarImag, "v");

例 2：

/* inRealおよび inImagは */

/* ユーザー定義のローカル変数で、*/

/* ASCET で見ることはできません。*/

/* スカラなので、ユーザーは明示的にメモリを */

/* 確保する必要はありません ! */

double inReal;

double inImag;

MIExecute("v = 3 - 4i;");

inReal double 型へのポインタ

inImag double 型へのポインタ

MatlabVarName  文字列
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MIGetComplexScalar(&inReal, &inImag, "v");

参照：

→ "MIGetScalar"

→ "MIGetComplexMatrix"

→ "MIGetComplexVector"

5.4.9 MIGetString

構文：

bool MIGetString( char *destBuffer,

char *MatlabVarName )

引数：

機能：

MIGetStringを使えば、MATLAB ワークスペース から文字列を受け取ることが
できます。データはバッファ destBufferに格納されます。

成功すれば trueを、そうでなければ falseを返します。

例：

char Buffer[2048];

MIExecute("aString = 'Hello world!'");

MIGetString(Buffer, "aString");

参照：

→ "MIIsString"

5.5 データ属性のチェック

本項で紹介する関数を使用して、MATLAB ワークスペース 内の変数のサイズと型
を調べることができます。

destBuffer MATLAB 文字列を格納するための文字列バッファ

MatlabVarName 文字列が格納されている MATLAB 変数の名前
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5.5.1 MIGetNCols

構文：

int MIGetNCols( char *MatlabVarName )

引数：

機能：

MatlabVarNameで指定された MATLAB 構造体（マトリックス、ベクトル、ある
いはスカラ）の列数を返します。

例：

int nc;

nc = MIGetNCols("Fibo");

参照：

→ "MIGetNRows"

5.5.2 MIGetNRows

構文：

int MIGetNRows( char *MatlabVarName )

引数：

機能：

MatlabVarNameで指定された MATLAB 構造体（マトリックス、ベクトル、ある
いはスカラ）の行数を返します。

例：

int nr;

nr = MIGetNRows("Fibo");

参照：

→ "MIGetNCols"

MatlabVarName MATLAB 変数の名前が格納されている文字列

MatlabVarName MATLAB 変数の名前が格納されている文字列
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5.5.3 MIIsComplex

構文：

bool MIIsComplex( char *MatlabVarName )

引数：

機能：

MATLAB 変数が複素数なら trueを、そうでなければ falseを返します。

例：

double *inReal, *inImag;

if (MIIsComplex("Matrix"))

MIGetComplexResult(&inReal, &inImag, 

"Matrix");

else

MIGetResult(&inReal, "Matrix");

参照：

→ "MIIsReal"

→ "MIIsEmpty"

→ "MIIsString"

5.5.4 MIIsEmpty

構文：

bool MIIsEmpty( char *MatlabVarName )

MatlabVarName MATLAB 変数の名前が格納されている文字列
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引数：

機能：

MATLAB 変数が空なら trueを、そうでなければ falseを返します。

例：

double *in;

if ( ! MIIsEmpty("Matrix") ) 

MIGetResult(&in, "Matrix");

参照：

→ "MIIsReal"

→ "MIIsComplex"

→ "MIIsString"

5.5.5 MIIsReal

構文：

bool MIIsReal( char *MatlabVarName )

引数：

機能：

MATLAB 変数が実数なら trueを、そうでなければ falseを返します。

例：

double *inReal, *inImag;

if (MIIsReal("Matrix"))

MIGetResult(&inReal, "Matrix");

MatlabVarName MATLAB 変数の名前が格納されている文字列

注記

空（[ ]）の MATLAB 変数とは、存在しているがまだ値が代入されていない
MATLAB 変数のことです。

MatlabVarName MATLAB 変数の名前が格納されている文字列
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else

MIGetComplexResult(&inReal, &inImag, 

"Matrix");

参照：

→ "MIIsComplex"

→ "MIIsEmpty"

→ "MIIsString"

5.5.6 MIIsString

構文：

bool MIIsString( char *MatlabVarName )

引数：

機能：

MATLAB 変数が文字列なら trueを、そうでなければ falseを返します。

例：

char in[1024];

if (MIIsString("A"))

  MIGetString(in, "A");

else

printf("Referenced variable is not a character 
string!");

参照：

→ "MIIsComplex"

→ "MIIsEmpty"

→ "MIIsReal"

MatlabVarName MATLAB 変数の名前が格納されている文字列
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5.6 エラー処理

本項では、MATLAB ワークスペース 内で発生するエラーに対処するために MIP が
内部的に使用する関数を紹介します。MIP には MATLAB エラーに対する処理がす
べて含まれていますが、以下の関数はユーザーが直接呼び出すためのものではあ
りません。ですから本項は、これらの関数の使用方法を説明するのではなく、エ
ラーに対する内部処理を理解していただくために記述されています。

MATLAB エンジンにはエラー処理ルーチンが用意されていないので、MATLAB エン
ジンの関数を使用して、専用のルーチン群が開発されました。MATLAB には、ユー
ザーコールに起因する最新のエラーについてのメッセージ文字列を返す、
lasterrという関数があります。原則として、MATLAB エラーが発生するのは、
MIP 関数 MIExecute、MIExecuteAndEcho、
MIExecuteWithoutErrCheckのいずれかをコールした場合のみです。

これらの MIP 関数のうち、MIExecuteおよび MIExecuteAndEchoのみが
checkMatlabErrorというメインエラー処理ルーチンを使用します。発行され
る lasterrエラーメッセージにアクセスするには、MIExecuteの機能が必要
です。エラーチェックが無限に繰り返されるのを防ぐために、
MIExecuteWithoutErrCheckが実行され、エラーが発生したかどうかを
MIErrorStatus内で調べ、エラーがある場合には、MATLAB ワークスペース 内
の一時変数にエラーメッセージ文字列を代入してから、MIGetLastError内で
MIGetStringコールを使用してその一時変数を MIP 環境に転送します。その
後、不正なエラーメッセージが出力されないように、MATLAB 内では lasterr
メッセージがリセットされて空の文字列になります。

以上のことから、MIP の通常の使用においては、checkMatlabError や
MIExecuteWithoutErrCheckを直接呼び出しても意味がないことがわかりま
す。

5.6.1 checkMatlabError

構文：

void checkMatlabError( void )

引数：

なし。

機能：

このメインエラーチェック／処理ルーチンは、MIExecute内部で起動され、
MATLAB 環境内でエラーが発生したかどうかを調べます。エラーメッセージが
ASCET Target Server のエラー例外処理に渡され、MATLAB の lasterrがリセット
されます。

この関数を直接使用することはお勧めできません。通常、エラーのチェックと処
理は、内部で行われます。
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参照：

→ "MIGetLastError"

→ "MIErrorStatus"

5.6.2 MIErrorStatus

構文：

bool MIErrorStatus( void )

引数：

なし。

機能：

MATLAB ワークスペース 内でエラーが発生している場合には trueを返します。

この関数は内部で使用するためのもので、ユーザーが直接使用することはお勧め
できません。通常、エラー処理は内部で行われます。

参照：

→ "checkMatlabError"

→ "MIGetLastError"

5.6.3 MIGetLastError

構文：

bool MIGetLastError( char *buffer )

引数：

機能：

最新の MATLAB エラーメッセージが bufferに書き込まれます。

この関数は内部で使用するためのものです。通常、エラー処理は内部で行われる
ので、ユーザーがこの関数を直接使用することはお勧めできません。

参照：

→ "MIErrorStatus"

→ "checkMatlabError"

buffer 文字バッファ
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5.7 内部関数

本項に含まれる関数は、内部で使用するためだけに作られたものであるため、こ
こでは簡単に概要を記述します。

5.7.1 MIActivateBuffer

構文：

bool MIActivateBuffer(char *Buffer,

int buflen )

引数：

機能：

Bufferに指定されたバッファを起動し、MIExecute などのファンクション
コールの結果として得られる MATLAB 出力を取り込みます。

バッファは、MIExecute、MIExecuteAndEcho、または
MIExecuteWithoutErrCheckの次回の実行で、自動的にクリアされます。

ユーザーがこの関数を直接使用することはお勧めできません。直接使用した場合、
それが MIExecuteWithoutErrCheckの前に実行された場合に限り、空でない
バッファが得られます。

MIExecuteが実行された場合、内部でエラー処理が行われるので、MATLAB 出力
はバッファに取り込まれません。MATLAB ワークスペース の出力にアクセスする
には、MIExecuteAndEchoを使用してください。

参照：

→ "MIExecuteAndEcho"

5.7.2 miAsc2Char

構文：

bool miAsc2Chars( char *destination, 
double *source, 
int NOfElements )

Buffer 文字バッファ

buflen Bufferの長さ
Matlab インターフェース － リファレンス



引数：

機能：

この関数は、文字列転送のために MIGetString内部で使用され、MATLAB 文字
列の ASCII コードが格納されている double型配列を受信します。この配列はさ
らに C文字列に再構築され、*destinationに代入されます。

ユーザーがこの関数を直接使用することはお勧めできません。

参照：

→ "MIGetString"

destination エコー先の文字列のポインタ

source double型配列へのポインタ
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6 MATLAB インターフェース － トラブルシューティング

エラーメッセージ 発行元関数 考えられる原因

Cannot start MATLAB MIOpen • MATLAB 6.5 以降のバージョンがイ

ンストールされていますか ?
• MATLAB は正しくインストールされ

ていますか ?
• 正しいプラットフォームを使用し

ていますか ? （MIP は Windows 
3.11 以前では実行できません。）

Closing MATLAB engine 
failed. Maybe 
connection was already 
closed.

MIClose • すでに MICloseで MATLAB を閉

じていませんか（あるいは MATLAB 
ワークスペース が終了してしまって

いませんか）?

Retrieving data failed. 
Referenced variable 
either does not exist, or 
is not of type DOUBLE 
ARRAY.

MIGetファミリ、

MIGetNRows、
MIGetNCols、
MIIsComplex、
MIIsReal、
MIIsEmpty、
MIGetString

• 参照されている MATLAB 変数が存

在しないか、数値ではありません。

• 使用できるのは、スカラ、ベクト

ルおよび 2 次元マトリックスのみで

す。

• MATLAB 変数が文字列ではありませ

んか ?（MIIsString、
MIGetStringを使用してくださ

い。）

No connection to
MATLAB

MIExecuteファミリ • MIOpenを忘れていませんか ?
• 接続が失われているか、MATLAB が

クラッシュしていることも考えられ

ます。

MATLAB variable 
referred to is not of 
complex type

MIGetComplex
ファミリ

• データは複素数ではありません。

MIIsComplexで確認することをお

勧めします。

Put operation failed MIPutファミリ • ASCET データを MATLAB に転送す

ることはできません。
• MIOpenを忘れていませんか ?

An error has occurred 
inside MATLAB

MIExecuteファミリ • MATLAB コードに誤りがあります。

（MATLAB エラーメッセージを参照し

てください。）

MATLAB ワークスペース 内で先に
コードを調べてから、ASCET にイン

ストールすることをお勧めします。
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7 Simulink ¨インターフェース

Simulink インターフェースによって、Simulink で作成されたモデルを ASCET にイ
ンポートすることができます。Simulink モデルをインポートするには、Real-Time 
Workshop® を使用してモデルから C コードを生成し、そのコードを ASCET にモ
ジュールとして組み込みます。モデルの実行に必要なタスクやプロセスは、
ASCET で自動生成されます。

サポートされている MATLAB バージョン

Simulink インターフェースは、以下のバージョンの MATLAB をサポートしていま
す。

• MATLAB R13.1：

MATLAB 6.5, Simulink 5.1, Real-Time Workshop 5.1, 
Stateflow 5.1 + Stateflow Coder 5.1（オプション）

• MATLAB R14.3：

MATLAB 7.1, Simulink 6.3, Real-Time Workshop 6.3, 
Stateflow 6.3 + Stateflow Coder 6.3（オプション）

上記の各プログラムは、モデルのインポート時に使用されます。ASCET でモデル
をシミュレートする際には、MATLAB、Simulink、RealTime Workshop は必要あり
ません。

7.1 概要

以降の各項の記述は、Simulink モデルを ASCET にインポートして使用することを
目標とするユーザーを対象としています。ここでは Simulink と Real-Time 
Workshop （RTW) に関する充分な知識と、ASCET と MATLAB での作業の経験が必
要です。

7.2 システムアーキテクチャ

図 7-1 は、Simulink インターフェースのシステムアーキテクチャを簡単に示した
ものです。ASCET と MATLAB/Simulink の間の通信は ASCET の自動化インター
フェースを通じて行われるので、ユーザーがこれを意識することはありません。
用途に応じて、MATLAB/Simulink が ASCET を、あるいは ASCET が MATLAB/
Simulink をリモート制御します。

Simulink モデルがインポートされるときには、実際のモデルファイルとそれに関
連する S ファンクションが Simulink に読み込まれ、Real-Time Workshop がそれ
を C コードに変換します。このコード生成には、スクリプトによって制御される
Target Language Compiler が使用され、このスクリプトの中に ASCET への組み込
みに必要な情報が含まれています。そしてこの C コードから、Simulink 統合パッ
ケージによって ASCET モジュールが生成され、この過程は、ETAS 固有のコン
フィギュレーションファイルによってコントロールされます。
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インポートが完了したモデルは、Simulink モデルをカプセル化した 1 つの ASCET
モジュールとなり、このモジュールが既存の ASCET プロジェクトに組み込まれま
す。このモジュールに必要なタスクやプロセスは自動的に生成され、適切に設定
されます。

図 7-1 Simulink インターフェースのシステムアーキテクチャ
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7.3 インポートされた Simulink モデルの内容

Simulink インターフェースによって生成される ASCET モジュールには、Simulink
モデルの全体と Simulink 数値演算ルーチンが、C コードの形式で含まれます。モ
ジュール名には、Simulink モデルのファイル名が使用されます（たとえばファイ
ル名が gas_eng.mdlの場合、モジュール名は gas_eng）。

本章では、Simulink モデルをインポートしたときに生成されるすべての ASCET
データベースアイテムについて説明します。

7.3.1 モデル変数のマッピング

各 Simulink 変数は、それぞれ個別の ASCET 変数にマッピングされます。下の表
は、その対応関係をまとめたものです。

最上位モデルレベル（ルートレベル）の入力ポートブロックと出力ポートブロッ
クだけが ASCET の送信メッセージと受信メッセージにマッピングされます。幅 
が 1 より大きい入力ポートブロックおよび出力ポートブロックは、複数の送信
メッセージと受信メッセージにマッピングされます。

Simulink 変数 ASCET 変数

幅が 1 である、
最上位モデルレベルの入力ポートブロック

受信メッセージ

幅が 1 である、
最上位モデルレベルの出力ポートブロック

送信メッセージ

幅が 1 より大きい、
最上位モデルレベルの入力ポートブロック

複数の受信メッセージ

幅が 1 より大きい、
最上位モデルレベルの出力ポートブロック

複数の送信メッセージ

スカラパラメータ パラメータ

ベクトルパラメータ 配列パラメータ

行列パラメータ 行列パラメータ

スカラの連続または離散ステート 変数

ベクトルの連続または離散ステート 配列変数

スカラのブロック出力ポート 変数

ベクトルのブロック出力ポート 配列変数
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7.3.2 プロセス

モデルのインポート時に、C 言語で実装された以下のプロセスが ASCET モジュー
ル内に生成されます。

シミュレーションの 1 ステップの演算が実行される時には、まず ASCET の受信
メッセージが Simulink の入力ポートブロックの信号にコピーされてから、実際の
演算処理が実行されます。そして、Simulink の出力ポートブロックの信号が
ASCET の送信メッセージにコピーされます。

インポートされた Simulink モデル内のパラメータを適合する場合は、
update_parasプロセスが必要です。このプロセスが実行されるたびに、
ASCET 実験環境で変更された内容がすべて Simulink モデルに転送されます。

また、インポートされた Simulink モデルのステート変数の値とブロックの出力
ポート信号を画面表示するには、update_statesプロセスが必要です。このプ
ロセスが実行されると、対応する ASCET 変数の値が更新されます。

このように、update_parasプロセスと update_statesプロセスは、イン
ポートされた Simulink モデルの実行中に測定と適合を行う場合に限り必要です。
このような Simulink プロセスの実行には時間がかかるので、他のモデル（ステッ
ププロセス）よりも大きいインターバルで実行されるようにしてください。

図 7-2 は、各種変数とそれらを処理するプロセスとの関係を示しています。

図 7-2 データとプロセス

プロセス 説明

init モデルと積分処理を初期化します。

step シミュレーションの 1 ステップの演算を実行します。

exit モデルを終了し、その作業メモリを解放します。

update_paras ASCET パラメータを Simulink パラメータにコピーします。

update_states Simulink のステート変数とブロックの出力ポートを ASCET 変
数にコピーします。

インポートされた
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入力ポート
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7.3.3 タスク

前述の各プロセスを実行するために必要なタスクは、Simulink 統合機能により自
動的に生成され、ASCET プロジェクトエディタの“OS”タブで内容を確認するこ
とができます。各タスクには、必要なプロセスが自動的に割り当てられます。

update_parasプロセスと update_statesプロセスについては、タスクは生
成されません。モデルのサイズによってはこれらのプロセスの実行に非常に長い
時間がかかる場合があるので、これらのプロセスの実行タイミングはユーザーが
指定します。通常、これら 2 つのプロセスは、stepタスクよりも大きなイン
ターバルで実行されるようにしてください。sim_stepタスクの周期は Simulink
モデル内で定義されたステップサイズに相当します。

7.3.4 クラス

モデルのインポート時には、非常に多くのクラスが ASCET データベース内に生成
され、これらのクラスが、生成されたモジュールのプロセスから参照されます。
クラスの数と名前はインポートされたモデルにより異なりますが、以下のクラス
は必ず生成されます。

7.3.5 生成される変数の名前

Simulink モデルの各変数に対応して、ASCET 変数が 1 つずつ生成されます。
ASCET で生成される変数の名前は、パス名と変数名の 2 つの部分で構成されてい
ます。このうち、変数名の部分は、Real-Time Workshop で生成された C コード内

タスク プロセス 設定

sim_init init init トリガ、active モード

sim_step step timer トリガ、active モード

sim_exit exit init トリガ、inactive モード

注記

タスク名は、Real-Time Workshop のオプション設定によって変更することがで
きます。タスク名が変更された後に Simulink モデルが再度インポートされた場
合、以前のタスクとプロセスは自動的に削除されません。それらはマニュアル
操作で削除してください。
このことは、Simulink モデルが ASCET プロジェクトエディタの“Elements”
ペーンで削除された場合にもあてはまります。

クラス 説明

<model>_<model> モデルの初期化と演算のための Simulink コードが含まれ
ています。

<model>_es_main Simulink 積分処理の初期化とシミュレーションステップ
の演算実行のための Simulink コードが含まれています。
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の変数名で、パス名の部分は、その変数が定義されている Simulink ブロックのパ
スです。これら 2 つの部分の間はアンダースコア 2 文字（“__”）で区切られま
す。

生成される変数の例

例として、Vehicle_aという Simulink モデルに Engineというブロックが含ま
れていて、そのブロックの中には Cylinderというブロックが、そしてさらにそ
の中に n_engineという変数が含まれていると仮定します。この場合、変数
n_engineのパスは Vehicle_a/Engine/Cylinderとなります。また、
Real-Time Workshop では、n_engineのブロック出力用として s1_n_engine
というような内部名を生成します。その結果、ASCET 変数の名前は以下のように
なります。

Vehiclea_Engine_Cylinder__s1_n_engine_B.

この名前においては、各ブロック名はアンダースコアで区切られています。また
RTW が生成する内部名は、2 文字分のアンダースコア“__”によってブロックパ
スの部分と区切られています。サフィックスの _Bは、この変数がブロック出力
であることを示しています。

RTW オプションダイアログ（73 ページの表 7-1 を参照してください）において
Reverse Quantity Names オプションがオンになっている場合、ASCET の変数名
は逆の順番（<variable name>__<path name>）で生成されるので、前述の
変数の例では、以下のようになります。

s1_n_engine_B__Vehiclea_Engine_Cylinder

変数のタイプにより、以下のいずれかのサフィックス（接尾辞）が変数名に付加
されます。

幅 が 1 より大きい入力ポート／出力ポートブロック用には、ASCET 内で複数の変
数が生成されます。このようなブロックの Simulink 名には、プレフィックスが付
きません。たとえば、outという名前の出力ポートブロックについては、変数
out_01、out_02、out_3... が生成されます。

生成される変数の名前の長さは、最長で 128 文字です。各変数の長さの合計がこ
れを超える場合、各変数名は自動的に省略されて短くなります。

注記

変数名が生成される際、ブロックパスの各エレメント名に含まれる英数字以外
の文字（たとえば Vehicle_a内の“_”）は削除されます。

変数タイプ サフィックス

パラメータ _P

連続ステート変数 _C

離散ステート変数 _D

ブロック出力 _B
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7.4 モデルのインポート

この項では、以下の内容について説明します。

• モデルインポートの実行（69 ページ）

• インポートしたモデルの扱い（80 ページ）

注意事項

モデルのインポートを行う際は、以下の点に注意してください。

• ブロック名、出力名、パラメータ名に使用できる文字は、英数文字とアン
ダースコアのみです。他にいくつか使用できる特殊文字もありますが、そ
れらによってエラーが発生する場合があります。

• “signal names”という出力を定義しておいてください。

• エラーが発生した場合は、grt_malloc.tlc コード生成が実行できるかを確認
してください。エラーが解消されない場合、エラーの原因についての詳し
い情報が表示されます。

• user.*ファイルの保存を行う必要があるため、モデルは書込み禁止にし
ないでください。

モデルインポートの実行

モデルのインポート処理は、以下に説明するいくつかのステップに分かれます。

• RTW オプションを設定する（R13 の場合）：（69 ページ）

• RTW オプションを設定する（R14 の場合）：（71 ページ）

• Simulink モデルをインポートする：（75 ページ）

• 検索パスを指定する：（77 ページ）

• インポートされたモデルをセットアップする：（78 ページ）

• 複数の Simulink モデルのインポート（78 ページ）

RTW オプションを設定する（R13 の場合）：

• Simulink モデルを開きます。

• Simulink から Tools → Real-Time Workshop → 
Options を選択します。

“Simulation Parameters”ダイアログボックスが
開きます。

• “Real-Time Workshop”タブを選択します。

• “System target file”フィールドにETASターゲット 
etas.tlcを入力します。

Make コマンドや Make ファイルテンプレートの
値が自動的に挿入されます。
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• “Category”コンボボックスから、ETAS 
Simulink Import General Settingsとい
うエントリを選択します。

• オプション設定を行います。

• “Category”コンボボックスから、ETAS 
Simulink Import Advanced Settingsと
いうエントリを選択します。

• オプション設定を行います。

各オプションについては、73 ページの表 7-1 を
参照してください。
Simulink® インターフェース



• “Solver”タブを選択します。

• “Solver Options”フィールドで Fixed-stepを選
択し、さらに適切なソルバを選択します。

• すべての設定が終わったら、OK をクリックしま
す。

RTW オプションを設定する（R14 の場合）：

• Simulink モデルを起動します。

• Simulink から Simulation → Configuration 
Parameters を選択します。

“Cofiguration Parameters”ダイアログボックスが
開きます。

• “Cofiguration Parameters”ダイアログボックスの
“Select”ペーンで、Real-Time Workshopと
いうエントリを開きます。

• “System target file”フィールドにETASターゲット 
etas.tlcを入力します。

Make コマンドや Make ファイルテンプレートの
値が自動的に挿入されます。

• Real-Time Workshopエントリを展開して
ETAS Simulink Import General 
Settingsというエントリを開きます。
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• オプション設定を行います。

• “Select”ペーンの ETAS Simulink Import 
Advanced Settingsというエントリを開きま
す。

• オプション設定を行います。

各オプションについては、73 ページの表 7-1 を
参照してください。

• “Select”ペーンの Solver というエントリを開き
ます。

• “Solver Options”フィールドで Fixed-stepを選
択し、さらに適切なソルバを選択します。

• すべての設定が終わったら、OK をクリックしま
す。
Simulink® インターフェース



RTW オプションの設定内容

表 7-1 コード生成オプション

上記以外にもいくつかのオプションがあります。これらのオプションは ETAS 固
有のものではないので、Real-Time Workshop のマニュアルを参照してください。
以下に、それらのオプションの中から特に重要なものをあげて簡単に説明します。

• Show eliminated statements（R13、R14）

コード生成に必要ないステートメントがコメントになります。

• Loop rolling threshold（R13）/ Loop unrolling threshold （R14）

基本ブロックの入出力用の配列を持つすべてのエレメントについて、同じ
設定が行われる必要があります。配列長がこのしきい値よりも長くなる
と、for ループが生成されます。そして同様の配列を持つ各エレメントに
ついて同様のコードが生成されます。

• Verbose builds（R13）/ Verbose build（R14）

コード生成の進行状況がメッセージと共に出力されます。

オプション 意味

Database すでにインポートされているモデルが格納されている
ASCET データベースです。

Folder すでにインポートされているモデルが格納されている、
ASCET データベースのフォルダです。

Project Simulink モデルが格納されている ASCET プロジェクト
です。

[...] Task Name Simulink インターフェースによって作成されるタスクの
名前です。詳細は、67 ページの「タスク」という項を参
照してください。

Reverse Quantity Names 変数名とパス名の位置が逆になっている変数名を生成し
ます。詳細は、67 ページの「生成される変数の名前」と
いう項を参照してください。

Generate Tables Simulink テーブルを ASCET テーブルにマッピングしま
す。それ以外の場合は、ASCET 配列やマトリックスが生
成されます。

C-Compiler Optimize ES113x で使用される DIAB データコンパイラは、デフォ
ルト設定においては最適化を行いません。このオプショ
ンがオンになっていると最適化が行われます。

Generate Flat Names 
For Parameters

モデルのすべてのパラメータがワークスペース変数とし
て定義されている場合にのみ、このオプションをオンに
します。
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• Inline invariant signals（R13、R14）

接続された入力により常に一定の値となるブロック出力値が、削除されま
す。

• Local block outputs（R13）/ Enable local block outputs（R14）

このオプションがオンになっていると出力値用にローカル変数が生成さ
れ、オフになっているとグローバル変数が生成されます。

• Force generation of parameter comments（R13）
/ Verbose Comments for SimulinkGlobal Storage Class（R14）

このオプションがオンになっていると、オリジナルのパラメータ名とブ
ロック名を含むパラメータについて、コメントが生成されます。オプショ
ンがオフになっていると、モデル内に 1000 以上のパラメータが含まれる
場合、コメントは生成されなくなります。パラメータ数が 1000 未満の場
合は、このパラメータはコード生成に影響を与えません。

• Buffer reuse（R13）

コード生成時に、各変数ごとに個別のメモリを割り当てず、不要になった
メモリを再利用します。 

• Include system hierarchy number in identifiers（R13 のみ）

生成される名前の長さに影響します。

• Expression folding（R13 のみ）

“Expression folding”は、複数の式を組み合わせて 1 つの短い式を作成す
る（つまり「式を畳み込む」）機能です。これによりコードは効率化され
ますが、これは単純な Simulink 基本ブロックが使用されている場合にのみ
適用されます。これによって変更される中間出力も削除されるため、通常
はこのオプションはオフにしておいてください。この機能により S ファン
クションの各出力値用にそれぞれ変数が生成されるため、モデルに S ファ
ンクションのみが含まれ Simulink 基本ブロックが含まれない場合は、この
オプションはコード生成に影響しません。

注記

このオプションによってコードの効率は向上しますが、この出力値をモ
ニタすることができなくなります。

注記

警告： この機能により、モニタされる出力値が正しく表示されなくなる
場合があります。通常このオプションはオフにしておいてください。

注記

R14 の場合、この「式の畳み込み」機能は複数のオプションでモードを
設定する必要があります。詳しくは RTW のユーザーズガイドをお読み
ください。
Simulink® インターフェース



• Fold unrolled vectors（R13 のみ）

入出力用の配列を持つ式も畳み込まれます。

• Enforce integer downcast（R13）
/ Ignore integer downcasts in folded expressions（R14）

このオプションは常にオンにしておいてください。オフになっていると
オーバフロー（たとえば 32 プロセッサでの 8 ビットまたは 16 ビット演
算によるオーバーフロー）が発生する可能性があります。

• Generate comments（R13） / Include comments （R14）

コード内にコメントを生成します。

“Simulation Parameters”ダイアログの“Advanced”タブでは、Real-Time 
Workshop のコード生成に影響するオプションを設定でき、これらのオプション
を以下に簡単にまとめます。詳しくは Simulink のマニュアルを参照してくださ
い。

• Inline parameters（R13、R14）

すべてのパラメータが“inline”として扱われます。つまり、それらの値
が定数として使用され、これはつまり、コード内のすべての依存式が必要
に応じて単純化されることを意味します。しかしこのようにコード生成さ
れたパラメータの値は、以後の変更ができなくなります。パラメータ値が
MATLAB ワークスペースから提供される場合、“Configure...”ボタンを使
用して、各パラメータごとに設定を行うことができます。

• Block reduction（R13） / Block reduction optimization（R14）

“Expression folding”に似た機能です。通常はオフにしておいてください。

• Boolean logic signals（R13）
/ Implement Logic Signals as Boolean Data（R14）

旧バージョンの Simulink では許可されていなかったコードの妥当性を
チェックします。旧バージョンのモデルを使用している場合以外は、常に
オンにしておいてください。

• Parameter pooling（R13 のみ）

このオプションは、モデルのパラメータが MATLAB ワークスペース内で定
義されていて、同一の配列が非常に多く存在している場合にのみ影響しま
す。通常はオフにしておいてください。

• Signal storage reuse（R13、R14）

RTW に対してシグナルメモリの再利用を要求します。“Buffer reuse”と似
た機能です。通常はオフにしておいてください。

Simulink モデルをインポートする：

• ASCET のコンポーネントマネージャを開きます。
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• 新しいプロジェクトを作成し、プロジェクトエ
ディタで開きます。

または

• プロジェクトエディタで既存のプロジェクトを開
きます。

• プロジェクトエディタで Simulink → Import 
Model を選択します。

“Simulink Integration”ダイアログボックスが開
きます。

• インポートする Simulink モデルを選択します。

“Selected Directory”フィールドに現在のディレ
クトリツリーが表示されます。

• 外部の C ソースコードやオブジェクトファイルを
使用しない単純なモデルの場合、検索パスを指定
する必要はありません。

• OK をクリックします。
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検索パスを指定する：

• 上記の“Simulink Integration”ダイアログの
“Select Directory”フィールドでパスを選択して > 
ボタンをクリックすると、そのパスが“Selected 
Include Search Paths”リストに追加されます。

コンパイラは、S ファンクションなどによって使
用されるインクルードファイルを、これらのパス
から検索します。

選択されたパスに格納されている C ソースとオブ
ジェクトファイルが“Select File”リストに表示さ
れます。

• このリストからファイル（1 つまたは複数）を選
んで > ボタンをクリックすると、選択されたファ
イルが“Selected C Source Files and Object Files”
リストに追加されます。

これらのファイルは後にリンクされます。これら
は、S ファンクションによって呼び出されるサブ
ルーチンが含まれるものです。

• OK をクリックします。

上記の操作によって Simulink モデルがインポートされます。実際には 65 ページ
の「インポートされた Simulink モデルの内容」に示されているデータ構造体が、
ASCET データベース内に生成されます。MATLAB は、モデルのインポート実行時
に自動的に起動され、インポート過程の個々のステップが MATLAB コンソール
ウィンドウに表示されます。この時発生する可能性のあるエラーについての詳細
は、83 ページ「トラブルシューティング」 の章を参照してください。

モデルインポートが正常に終了した後、オペレーティングシステムおよびグロー
バル通信に関して以下のような設定を行ってください。

注記

これらのオブジェクトファイルが生成された時の
ターゲットとコンパイラが、プロジェクトのター
ゲットとコンパイラに一致している必要がありま
す。
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インポートされたモデルをセットアップする：

• update_statesおよび update_parasプロセ
スを、必要に応じて任意のタスクに割り当てま
す。

これらのプロセスは大きなインターバルで実行さ
れるのが普通なので、自動的には割り当てられま
せん。詳細は、66 ページの「プロセス」という
項を参照してください。

• グローバルエレメント（送信メッセージと受信
メッセージ）を作成、あるいは名前を変更して
Simulink 変数名にあわせ、プロジェクトのグロー
バル通信をセットアップします。

• Global Elements → Resolve Globals を選択し
て、グローバルエレメントの参照を解決します。

複数の Simulink モデルのインポート

Simulink インターフェースでは、1 つの ASCET プロジェクトに複数の Simulink モ
デルを連続してインポートすることができます。

この際、以下の点について注意してください。

• 各モデルごとにそれぞれユニークな名前をつけてください。つまり、対応
する .mdl ファイルの名前の最初の 6 文字が、他のファイルと異なるよう
にしてください。

• すべてのモデルで同一の積分処理（ソルバ）を使用してください （ 
ODE1、ODE4など）。

注記

Simulink インターフェースが生成した ASCET 変数（送信／受信メッセージな
ど）の名前は変更しないでください。変更してしまうと、その後同じモデルを
改めてインポートするたびに同じ変更作業を繰り返さなければならなくなりま
す。またプロジェクトに定義されているグローバルエレメントのうち、生成さ
れるエレメントにマッピングされるものの名前は、必ず変更してください。こ
うしておけば、モデルを再インポートした後も設定を変更する必要がありませ
ん。

注記

インポートされた Simulink モデルでオフラインシミュレーションを実行する際
は、シミュレーション実行開始前に、イベントジェネレータで“Exit”タスクを
無効にしておいてください。これを行わないと、L1 エラーによってシミュレー
ションが即時に終了してしまいます。
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• すべてのモデルで同一の Simulink タスクモデル（SingleTasking）を使
用してください。
ソルバモードとして SingleTasking が使用されていないと、以下の警告
メッセージが表示されます。

Yes をクリックするとモデルのソルバは SingleTasking に設定され、
No をクリックするとエラーメッセージが表示されます。

• モデルのインポート時に、すべての Simulink モデルが同じ基本ステップサ
イズを使用していること、またそうでない場合は各シミュレーションス
テップタスクの名前がそれぞれ異っていることを確認してください。

• モデルパーツが S ファンクションを使用している場合、ある特定の S ファン
クションは、インポートされる複数のモデルにおいて同時に使用されてい
ることが許されません。この場合、S ファンクションの名前を変更し、各
パーツからそれぞれ異なる名前で呼び出されるようにしてください。

• Simulink の各入力／出力に対して ASCET メッセージが生成されるため、た
とえば ModelAに pressure_Aという出力があり、ModelBにも
pressure_Aという入力がある場合、ASCET の一般的な規則に従って、
これらの入力と出力は暗黙的に接続されます（詳しくは、『ASCET リファ
レンスガイド』を参照してください）。

• シミュレーションステップタスクは、デフォルトでは sim_step という名
前です。このデフォルト設定は、Real-Time Workshop のオプション設定
で変更することができます。

注記

Simulink における統合プロシージャは、どのような場合でも必ず自動設
定によって行うようにしてください。自動設定を変更した場合、イン
ポート中やシミュレーション実行中にエラーが発生します。

注記

モデルの範囲を越えたシーケンシングは、複数の Simulink モデルがインポート
されたときに数値的な問題を招く原因となるため、行われません。インポート
されたモデルのシーケンシングは、適宜マニュアル操作で調整してください。
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7.4.1 インポートしたモデルの扱い

この項には、インポートされたモデルの使用方法に関する以下の項目について説
明します。

• ターゲットの変更（80 ページ）

• インポートとコンパイルを異なる ASCET セッション内で行う（80 ページ）

• ファンクションコールサブシステムを ASCET に組み込む（81 ページ）

ターゲットの変更

インポートしたモデルが、たとえば PC ターゲット用のものであった場合、それ
を実験ターゲット（ES1130 または ES1135）上で実行するには、そのモデルを新
しいターゲット用のものとしてコピーする必要があります。

インポートしたモデルを他のターゲット用にコピーする：

• プロジェクトエディタで、コード生成とターゲッ
トについてのオプションを、コピー先とするター
ゲットにあわせて変更します。

• Extras → Copy C-Code From を選択します。

• コピー元とするターゲットを、選択ボックスから
選択します。

モデルをインポートしたときに選択されていた
ターゲットを選択します。

• “OS”タブをクリックします。

• Operating System → Copy From Target を選択
します。

• モデルをインポートしたときに選択されていた
ターゲットを選択します。

• “Files”タブをクリックします。

• Project Files → Copy From Targetを選択します。

• モデルをインポートしたときに選択されていた
ターゲットを選択します。

これで、モデルのコンパイルと実験が行えるよう
になりました。

インポートとコンパイルを異なる ASCET セッション内で行う

ASCET のオプションダイアログで Keep files in Generation Directory on 
Shutdown オプションがオフになっていると（詳しくは『ASCET ユーザーズガイ
ド』を参照してください）、ASCET のコード生成ディレクトリである .¥cgen¥内
のファイルは、ASCET をシャットダウンした時に自動的に削除されます。このオ
プションをオンにすると、次回のセッションからファイルの削除は行われなくな
ります。
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前回のセッション終了時に .¥cgen¥ディレクトリ内のファイルが削除されてい
た場合、モデルのコンパイル時に必要なヘッダファイルやコンフィギュレーショ
ンファイルはハードディスク上には存在しません。しかしこれらのファイルの内
容は ASCET データベース内にプロジェクトと共に保存されているため、いつでも
ファイルを復元することができます。この作業は、前回の ASCET セッションにお
いてインポートされ、まだコンパイルされていないモデルを、今回のセッション
でコンパイルする場合に必要です。

プロジェクトファイルを復元する：

• プロジェクトエディタの“Files”タブをクリック
します。

• Project Files → Write all Files を選択します。

ファイルが復元されます。これで、前回のセッ
ションでインポートのみを行ったモデルをコンパ
イルできます。

ファンクションコールサブシステムを ASCET に組み込む

ファンクションコールサブシステムをインポートするには、インポートするブ
ロックについて以下のようにセットアップを行う必要があります。

ファンクションコールサブシステムをセッティングする：

• Simulink モデル内の“Function Call Subsystem”
ブロックを右クリックします。

• Subsystem parameters を選択します。

“Block Parameters: Function Call Subsystems！ダ
イアログ開きます。
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• 以下のように設定します。

Simulink インターフェースでファンクションコールサブシステムをインポートす
る際、そのサブシステム用にいくつかのプロセスが生成されますが、それらのプ
ロセスはタスクリストには組み込まれません。たとえば modelというモデルに
subsysという Simulink サブシステムを組み込む場合、以下のような 3 つの
ASCET プロセスが生成されます。

• subsys_initialize_model

• subsys_start_model

• subsys_model

サブシステムの組み込みは、以下のように行います。

ファンクションコールサブシステムのプロセスを組み込む：

• トリガの初期化を行う初期化タスクがまだ作成さ
れていない場合は、それを作成します。

• 初期化タスクに subsys_initialize_model
というプロセスを割り当て、メインの Simulink モ
デル内の *_init_*というプロセスの後に配置
します。
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• subsys_start_modelというプロセスを初期化
タスクに割り当て、
subsys_initialize_modelプロセスの後に、
最後のプロセスとして配置します。

複数の Triggered サブシステムが存在する場合は、
それらの初期化プロセス *_initialize_*は、
すべて *_start_* プロセスの前に実行される
ようにしてください。

• トリガ用のイベントタスクを作成します。

• Triggeredサブシステムから生成されたSimulinkプ
ロセス、subsys_modelをタスクに割り当てま
す。

タスクをトリガするイベントは、RTIO エディタなどにおいて、個別に定義する必
要があります。

7.5 トラブルシューティング

本項では、Simulink モデルをインポートするときに発生する可能性のあるいくつ
かの問題とその解決策について説明します。

MATLAB を起動できない

エラーメッセージ： “Fatal Error: Cannot start MATLAB engine.”

原因： MATLAB が PC 上にインストールされていません。

対策： 適切なバージョンの MATLAB をインストールしてください。

パス名の空白文字によってインポートエラーが発生する

エラーメッセージ： “Error (execstring): 0 － Unterminated string” and “Error 
(execstring): -1 － syntax error” （MATLAB コマンドウィンドウに表示されます。）

原因： Simulink は、RTW オプションダイアログにおいて空白文字を含む文字列
を扱うことができません。

対策： ASCET データベースへのパスに空白文字が含まれないようにしてくださ
い。

Simulink モデルをコンパイルできない

原因 1： ASCET のシャットダウン時に cgenディレクトリが削除されました。

注記

上記の処理は、Simulink モデルをインポートする
たびに毎回行ってください。
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対策 1： プロジェクトファイルを復元してください。詳細は、80 ページの「イン
ポートとコンパイルを異なる ASCET セッション内で行う」という項を参照してく
ださい。

原因 2：Simulink モデルに外部 C コードが含まれています。

対策 2：Make コマンドを修正して、外部 C コードを統合します。詳細は、77
ページの「検索パスを指定する：」という項を参照してください。

オフラインシミュレーションがキャンセルされてしまう

エラーメッセージ： “L1-Message Fatal Error”

原因： ASCET がオフライン実験のイベントリストに Exit タスク sim_exit用の
イベントを挿入しました。

対策： イベントジェネレータでこの Exit タスク用のイベントを無効にします。

TCP/IP を正しく設定できない

エラーメッセージ： “Cannot start Tool server on port 32503”

原因 1： ドライバがインストールされていないか、または正しくインストールさ
れていません。PC カードが取り外されている可能性もあります。

対策 1： ネットワークの接続と設定を確認してください。

原因 2： TCP/IP が正しく設定されていません。ループバックアダプタが必要です。

対策 2： システム管理のご担当の方にご相談ください。
Simulink® インターフェース



8 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ヨーロッパ（フランス、ベルギー、ルクセンブルグ、イギリスを除く）

ETAS GmbH

フランス、ベルギー、ルクセンブルグ

ETAS S.A.S

イギリス

ETAS Ltd.

USA

ETAS Inc.

Borsigstrasse 14 Phone: +49 711 8 96 61-0

70469 Stuttgart Fax: +49 711 8 96 61-105

Germany E-mail: sales@etas.de

WWW: www.etasgroup.com

1, place des Etats-Unis Phone: +33 1 56 70 00 50

SILIC 310 Fax: +33 1 56 70 00 51

94588 Rungis Cedex E-mail sales@etas.fr

France WWW: www.etasgroup.com

Studio 3, Waterside Court Phone: +44 1283 - 54 65 12

Third Avenue, Centrum 100 Fax: +44 1283 - 54 87 67

Burton-upon-Trent E-mail sales@etas-uk.net

Staffordshire DE14 2WQ WWW: www.etasgroup.com

UK

3021 Miller Road Phone: +1 (888) ETAS INC

Ann Arbor, MI 48103 Fax: +1 (734) 997-9449

USA E-mail sales@etas.us

WWW: www.etasgroup.com
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日本

イータス株式会社

韓国

ETAS Korea Co., Ltd.

中国

ETAS (Shanghai) Co., Ltd.

〒 220-6217 Phone: (045) 222-0900

神奈川県横浜市西区 Fax: (045) 222-0956

みなとみらい 2-3-5 E-mail: sales@etas.co.jp

クイーンズタワー C 17F WWW: www.etasgroup.com

4F, 705 Bldg. 70-5 Phone: +82 2 57 47-016

Yangjae-dong, Seocho-gu Fax: +82 2 57 47-120

Seoul 137-889 E-mail sales@etas.co.kr

Korea WWW: www.etasgroup.com

2404, Bank of China Tower Phone: +86 21 5037 2220

200 Yincheng Road Central Fax: +86 21 5037 2221

Shanghai 200120 E-mail sales.cn@etasgroup.com

P.R. China WWW: www.etasgroup.com
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